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A short story is fiction – a work of literature in which the characters and 

events are imagined by the author.  Fiction allows you to explore new 
worlds, share the joys and sorrow of the characters, and learn from the 

invented experiences of others.  Through the short stories in this unit, we 
will follow our characters as they manage family relationships in life and in 
death, as the make choices that will affect their well being, as they deal with 

voids in their lives, and as they stand in mortal peril.  Come experience the 
lives of these characters, from the safety of your own seat!
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Short StoriesShort StoriesShort StoriesShort Stories 

 
Primary Curriculum Area:  Language Arts 

Additional Curriculum Areas: Mathematics, Information Skills, and Social 
Studies 

Primary Subject Area:  English I 
Additional Subject Areas:  Introductory Mathematics, Grade 9-12; Information Skills 
Grade 9, Psychology 

 9-12 Computer Technology Skills  
 

Suggested Grade Level: 9th Grade 
 
Edgar Allen Poe defined a short story as a tale that could be read in one sitting.  He believed short 
stories could have a powerful effect on the reader, despite their brevity. As you know, short 
stories are works of fiction, but you’ll find that the characters, plots, themes, settings, and other 
elements are very reflective of our real lives, for who among us has not experienced what some of 
these characters experience:  joy and sorrow, pain and fear, excitement and danger? 
 
The short stories in this unit are arranged thematically, focusing on the following subjects: 

1. Danger [Week One:  In Mortal Peril] 
! The Cask of Amontillado - Edgar Allen Poe 
! The Most Dangerous Game – Richard Connell 

2. Decisions [Week Two: Choices] 
! The Lady, or the Tiger – Frank R. Stockton 
! The Necklace – Guy de Maupassant 

3. Loneliness [Week Three:  Filling a Void] 
! The Secret Life of Walter Mitty – James Thurber 
! And Sarah Laughed – Joanne Greenberg 
! American History – Judith Ortiz Cofer 

4. Death [Week Four: A Death in the Family] 
! Before the End of Summer – Grant Moss, Jr.  
! The Scarlet Ibis– James Hurst 

5. Relationships [Week Five:  Love and Family Relationships] 
! Uncle Marcos – Isabel Allende  
! All the Years of Her Life – Morley Callaghan 
! The Gift of the Magi – O.Henry 

 
The stories selected for each week certainly fit into the overarching themes, yet as in all works of 
fiction, there are often multiple themes that can be discerned and discussed as we use fiction to 
explore the human condition. While reading and discussing the stories of this unit, and 
interweaving writing, video viewing, and technology exercises, a solid range of language arts and 
technology curriculum objectives can be met, and depending on the story studied, other 
curriculum areas can be interwoven, with examples in this unit meeting objectives in 
mathematics, information skills, and psychology.  
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Short Stories Short Stories Short Stories Short Stories ––––        
Included Lesson PlansIncluded Lesson PlansIncluded Lesson PlansIncluded Lesson Plans 

 
 
 Week One: In Mortal Peril 

Comparing Selections:  “The Most Dangerous Game”  
and “The Cask of Amontillado” [focus:  characterization] ....................................... 4 
 
 
 
Week Two: Choices 
Understanding Plot:  “The Lady, or the Tiger?” [focus:  plot] ................................. 12 
 
 
 
Week Three: Filling a Void 
“The Secret Life of Walter Mitty” – One More Daydream  
[focus:  point of view]............................................................................................... 22 
 
 
 
Week Four: A Death in the Family 
Writing about Theme:  “The Scarlet Ibis” [focus:  theme] ....................................... 32 
 
 
 
Week Five: Love and Family Relationships 
Short Story Wrap-Up [focus:  applying/reviewing the elements  
of the short story genre learned in the unit] .............................................................. 38 
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Language Arts 
 

Curriculum 
Area(s) 

English Language Arts  
Mathematics 

Subject Area(s) English I 
Introductory Mathematics, Grade 9-12 
9-12 Computer Technology Skills 
 

Week’s Theme Week One: In Mortal Peril . . . 
These characters experience critical events that threaten their sense of well-
being and reveal their values, characteristics, and approaches to life and 
death. 
 

Lesson Title Comparing Selections:  “The Most Dangerous Game” and 
“The Cask of Amontillado” 

Suggested Grade 
Level 

English I, 9th Grade 

Time 90 minutes (possible in one class session with block schedule) 
Equipment 
Needed and 
Availability 

! Teaching computer, and projector to project the information on the 
instructor computer 

! 5 additional computer stations in the classroom  
! Classroom printer, networked to all computers, including the 

instructor station 
! All computers have Microsoft Office 2000 with Excel. 
! Microsoft Office Handbook that has information on using Excel is 

available for each workstation as a reference 
! Chalkboard and colored chalk. 
! Comparing Selections:  “The Most Dangerous Game” and “The Cask 

of Amontillado” handouts (at end of lesson plan) 
! Grading Rubric (at end of the lesson plan) 
 

Prerequisite Skills 
in Subject Area 
One [Language 
Arts, English I) 

Students have completed the first week of the short story unit, and are 
beginning to understand the elements of the short story as examined in the 
following reading selections: 
“The Cask of Amontillado” - Edgar Allen Poe 
“The Most Dangerous Game” – Richard Connell 
In reading and discussing these stories, students have viewed the painting 
“The Hungry Lion” and discussed the “danger” of that painting, they have 
read, discussed and reviewed both stories, and are beginning to develop an 
understanding of characterization and setting.  They have also discussed 
manhunts as depicted by movies, and how films they have seen are similar to 
these stories.   
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Prerequisite Skills 
in Subject Area 
Two [Introductory 
Mathematics, 
Grades 9-12] 

Students are building on skills from earlier experiences with mathematics, 
including the ability to collect and analyze data and understanding the options 
for displaying data (such as through graphing).   
 

Prerequisite Skills 
in Technology: 

Students have already spent time using the computer for earlier assignments 
that have addressed the following skills in Excel: 

- Entering data in Microsoft Excel 
- Formatting text in Excel, including Merging and Centering  
- Using the AutoSum and AutoChart features 
 

Learning 
Objectives in 
Subject Area (s) 
[Language Arts 
and Introductory 
Mathematics] 

NCDPI objectives 
 
Language Arts, English I 
5.01 Read and analyze various literary works by: determining a character’s 
traits from his/her actions, speech, appearance, or what others say about him 
or her. 
 
Introductory Mathematics, Grade 9-12 
3.01 Collect, organize, analyze, and display data  (including scatterplots) to 
solve problems. 
 

Learning 
Objectives in 
Technology: 

NCDPI objectives 
 
Computer/Technology Skills Curriculum, Grades 9-12 
2.2 Select and use appropriate technology tools to efficiently collect, analyze, 
and display data. 
 

Instructions: In this lesson, students will be challenged to compare the characters, the 
elements of suspense, and the experiences of the two stories we have 
completed reading, “The Cask of Amontillado” by Edgar Allen Poe and 
“The Most Dangerous Game” by Richard Connell.  Keep in mind that both 
stories have been read and discussed, but not compared and contrasted with 
each other at this point. 
 
First part of class, approximately 35/40 minutes: 
 
Discuss “The Cask of Amontillado” and “The Most Dangerous Game” in 
terms of comparing and contrasting these stories with the students. Students 
should face an overhead projector or chalkboard (wherever the instructor can 
most easily draw a Venn diagram to help collect and analyze data). Remind 
students that that everyone will be graded on their participation and 
contributions (see rubric). Key questions to answer include, but are not 
limited to: 
 

1. Who are the main antagonists in each story (Montresor and General 
Zaroff)?  How are their actions, attitudes, and personality traits alike 
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and different? 
2. Zaroff and Montresor use similar strategies to attract Rainsford and 

Fortunato.  How does each man use a shared interest to lure and trap 
his guest? 

3. In what ways are Fortunato and Rainsford similar?  What’s different 
about their personalities and actions? 

 
For questions 1 – 3, draw a Venn diagram on the chalkboard representing the 
student’s responses.  Show them how a Venn diagram is very useful for 
organizing and analyzing information, and how it provides a good, visual way 
to compare and contrast different things.  Use the colored chalk as the Venn 
diagram is drawn to visually draw attention to the comparisons/contrasts. 
 

4. How does each of the authors build suspense?  Which story is more 
effective at building suspense and why? 

5. Which villain is scarier?  How has the author used both direct and 
indirect methods for characterizing the villains? 

6. Which “victim” best handles the situation? 
7. Which setting is more frightening, and why? 
8. Which “victim” do you relate to the most?  Why? 

 
Once questions 4 – 8 are completed, conduct a class poll so that everyone can 
have a final “vote” on these issues.  Write this on the chalkboard, and via a 
show of hands, poll the class in each of these areas: 
 
Category Name Votes Name Votes 
Scariest Villian? Montresor  Zaroff  
Best Plot? “The Cask of 

Amontillado” 
 “The Most 

Dangerous Game” 
 

“Smartest” 
Victim? 

Fortunato  Rainsford  

Most 
Frightening 
Setting 

“The Cask of 
Amontillado” 

 “The Most 
Dangerous Game” 

 

 
 
Vocabulary: 
Characterization – The methods an author uses to reveal a character’s 
personality, can be direct statements by the author or indirectly inferred 
through the character’s statements, thoughts, actions, and the statements, 
thoughts and actions of other characters 
Setting – Time, place, context in which a story occurs. 
 
 
Middle of class, approximately 10/15 minutes: 
Class should face the area of the room with the instructor’s projected 
machine. Instructor should comment that now that the students have 
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compared and contrasted these stories, and taken a poll to see which stories 
and characters were the winners of our poll (scariest villain, best plot, 
smartest victim, most frightening setting), that students are going to work 
with this data. 
 
While projecting the computer’s information to a screen all students can see, 
explain to each group that they will be given a “The Most Dangerous Game” 
and “The Cask of Amontillado” handout to work with the data we collected 
during this class poll (at end of lesson plan). Each group will then graph the 
data using Excel, following the directions on the handout.  Groups will also 
be asked to answer a question about why the class chose the winners, and be 
prepared to discuss their response with the class.  
 
The instructor should model using the AutoSum and ChartWizard functions 
in Excel for the students prior to dividing them in groups, reminding them 
how to graph the data and add titles, and share the grading rubric with the 
students. 
 
Divide class into groups of 3 or 4 students, creating 5 or 6 groups for the class 
(keeping in mind you have a total of 6 machines if necessary, as one group 
could use the instructor’s machine). 
 
Each group should be given one of the “The Most Dangerous Game” and 
“The Cask of Amontillado” handouts. 
 
Remainder of class, approximately 50/60 minutes: 
Students work in groups to chart their data, utilizing the computers in the 
classroom, referring to the Microsoft Office Handbook that has information 
on using Excel, and the “The Most Dangerous Game” and “The Cask of 
Amontillado” handouts (at end of this lesson plan for each group). 
 
With about 10 minutes remaining, ask the groups to share their thoughts 
about the last question on their handout with the remainder of the class. 
 
Next class session (s): 
If needed, finish the group discussions on characterizations.  Hand back the 
graded group work.  Will begin reading the next story in the series, “The 
Lady or the Tiger,” where we will build on what we have learned about 
setting and characterization and begin studying plot in more detail, as we 
build our knowledge of the genre of short story. 
 



ECI 511, Donna Petherbridge, Comprehensive Unit Plan 

 8

Evaluation of 
Subject Area One 
[Language Arts, 
English I] 

The instructor will note the verbal responses made by the class in the initial 
discussion to check for understanding of characterization. The instructor will 
personally reflect on the success of the lesson:  did the class seem engaged in 
the content?  Were their responses appropriate?  Meaningful?  Did they 
indicate depth of understanding?  The instructor will also assign points on the 
groups’ responses to the characterization question on their handout based on 
the last item on the rubric as well as their participation in the class discussion. 

Evaluation of 
Subject Area Two 
[Introductory 
Mathematics, 
Grades 9-12 ] 

The instructor will note the students’ verbal responses in the initial class 
discussion that contribute specifically to the Venn diagrams on the board.  
Are students able to give information relevant to the diagram to begin 
organizing and analyzing it in a meaningful way?  The instructor will also 
grade the spreadsheet, using the rubric. 
 

Evaluation of 
Technology 
Integration: 

Learning to utilize Microsoft Excel appropriately for projects is a necessary 
skill for students.  The instructor will note how well students are able to use 
excel to display the information effectively. The group’s Excel charts will be 
assessed by the rubric. Student motivation and enthusiasm for using Excel to 
do this project will also be assessed. 
 

Credits Teaching ideas, questions and options for comparing and contrasting 
characters are from the Teacher’s Wraparound Edition Glencoe Literature, 
The Reader’s Choice, Course 4, published by Glencoe McGraw-Hill, New 
York: 2000. 
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Comparing Selections:   
“The Most Dangerous Game” and “The Cask of Amontillado “ 
 

Category Name Votes Name Votes 
Scariest Villian? Montresor  Zaroff  
Best Plot? “The Cask of Amontillado”  “The Most Dangerous Game”  
“Smartest” 
Victim? 

Fortunato  Rainsford  

Most Frightening 
Setting 

“The Cask of Amontillado”  “The Most Dangerous Game”  

 
We have completed comparing and contrasting the “The Most Dangerous Game” and “The Cask of 
Amontillado,” and we have taken a class poll to find out people’s opinions concerning the scariest 
villain, the best plot, the “smartest” victim, and the most frightening setting.  You are now going to 
enter this information in a spreadsheet, create a graph of the data, and respond to some questions as 
you give these stories some more thought. 
 
Using the chart above, copy the number of votes from the class poll from the blackboard.  Then, 
working with your group, do the following using Microsoft Excel (note:  refer to your Microsoft Office 
Handbook as needed: 
 

1. Create a New Blank document. 
2. In cell A1, type Comparing Selections:  “The Most Dangerous Game” and “The Cask of 

Amontillado“ 
3. Merge and Center your title across cells A1 – J1. 
4. Make your title size 14, you can choose the font and font color. 
5. Type in the following table, exactly as you see it, beginning in cell A3 (Note the left hand 

column simply lets you know what to type in each cell, in the right hand column, you 
should type the result of the class poll): 
 

A3 Scariest Villian  
A4 Montresor Number from poll here 
A5 General Zaroff Number from poll here 
A6   
A7 Best Plot  
A8 The Cask of Amontillado Number from poll here 
A9 The Most Dangerous Game Number from poll here 
A10   
A11 Smartest Victim  
A12 Fortunato Number from poll here 
A13 Rainsford Number from poll here 
A14   
A15 Most Frightening Setting  
A16 The Cask of Amontillado Number from poll here 
A17 The Most Dangerous Game Number from poll here 
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6. For each poll, create a chart using the Chart Wizard that illustrates the results of the poll.  

Column, bar, and pie charts are fine.  Use at least 3 different types of charts to represent your 
data.  Also, make sure you do the following in the Chart Wizard: 

a. Give your chart a title (Titles tab, Chart Wizard). 
b. Show the legend for your chart on the right hand side (Legend tab, Chart Wizard). 
c. Show both the labels and the percent (Data Labels tab, Chart Wizard). 

7. Move your charts to the right of the data that you typed in, lining them up one on top of another 
UNDER the merged title.  You can resize your charts so that they aren’t too large to fit under 
the title where it ends in cell J1. 

8. Below the data that you typed in, type in the names of everyone in the group AND today’s date 
on the chart. 

9. Use the various formatting options to make your spreadsheet attractive.  Be creative and make 
this look nice! 

10. Print out and turn into the instructor AND print out a copy for your group. 
11. Then, as a group, referring to your printout with the chart, discuss the following question.  Be 

prepared to respond to this question to the remainder of the class at the end of class! 
Question:  Review the poll data and note which story or character received the largest number 
of votes for each area (scariest villain, best plot, smartest victim, most frightening setting).  
What elements in each story, or characteristics of each of the main characteristics, probably led 
your classmates to select the “winner”?  What elements of the story or characters for the “non-
winners” still assured they got some votes? 
 

 
 
 

 



ECI 511, Donna Petherbridge, Comprehensive Unit Plan 

 11

EEEEvaluation Rubric for “The Most Dangerous Game”  
and “The Cask of Amontillado” 
 
Group Members:    ___________________ 

___________________ 
___________________ 
___________________ 

 
 

100 possible points Total 
Possible 

Your 
Score 

Title per the directions 10  

Data typed in per the directions 10  

Chart created per the directions: 
 - Title on chart 
 - Legend on right of chart 
 - Labels and percent shown 
 

10  

Title centered and merged per the directions 10  
The fonts/style and formats you have chosen make the 
spreadsheet visually appealing 

10  

Group Names are on the spreadsheet, as well as date 10  
You participated in and contributed to the class discussion for 
“The Most Dangerous Game” and “The Cask of Amontillado” 

15  

Your group was able to articulately answer this question: 
Question:  Review the poll data and note which story or 
character received the largest number of votes for each area 
(scariest villain, best plot, smartest victim, most frightening 
setting).  What elements in each story, or characteristics of each 
of the main characteristics, probably led your classmates to 
select the “winner”?  What elements of the story or characters 
for the “nonwinners” still assured they got some votes? 

25  

Total Score:
Comments: 
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Language Arts 
 
 
 
 
 
 
 
 
 
 
 

Curriculum Area(s) English Language Arts  
Information Skills 

Subject Area(s) English I 
Information Skills Grade 9 
9-12 Computer Technology Skills 

Week’s Theme Week Two:  Choices 
These stories focus on characters that must make a choice – can one avoid 
mortal peril?  And the other, a lifetime of pointless sacrifice? 
 

Lesson Title Understanding Plot: “The Lady, or the Tiger?” 

Suggested Grade Level English I, Grade 9 

Time 90 minutes (possible in one class session with block schedule) 
Equipment Needed and 
Availability 

! Teaching computer, projector to project the information on the 
instructor computer 

! 5 additional computer stations in the classroom  
! Computers have floppy disk drives 
! All computers have Microsoft PowerPoint. 
! Computers should have internet access to use Microsoft’s Online 

Clip Art gallery 
! Several copies of the Microsoft Office Handbook are available for 

groups to look at. 
! Plot handout 
! “The Lady, or the Tiger?” handout 
! Handout on using Microsoft’s Clip Art gallery online with 

instructions for inserting Clip Art into PowerPoint slides 
! One disk, with a blank label, is needed for each group. 
 

Prerequisite Skills in 
Subject Area One 
[Language Arts, English I] 

Students have completed reading the short story, “The Lady, or the 
Tiger.”  In the previous week’s lesson, students focused on 
characterization and setting in reading “The Cask of Amontillado” and 
“The Most Dangerous Game.”  In this week’s stories, the focus will be on 
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plot, with the earlier stories referred to during the lesson. 
 

Prerequisite Skills in 
Subject Area Two 
[Information Skills, Grade 
9] 

As ninth graders, students are expected to form and support opinions, and 
work to persuade others to their point of view.  Earlier in this unit, 
students spent time doing this as they voted for the scariest setting and 
cruelest villain.  This lesson will expand on this skill, asking students to 
form an opinion in their groups and to be prepared to support their 
opinion with evidence.  
 

Prerequisite Skills in 
Technology: 

Students have already spent time using the computer for earlier 
assignments that have addressed the following skills: 

- Using Microsoft Excel in this unit. 
- Using Microsoft’s online Clip Art in an earlier lesson in the year. 
- Using Microsoft PowerPoint to create presentations earlier in the 

year. 
 

Learning Objectives in 
Subject Area (s) [Language 
Arts and Information 
Skills] 

NCDPI objectives 
 
Language Arts, English I 
5.01 Read and analyze various literary works by recognizing and 
analyzing the characteristics of literary genres, including fiction (e.g., 
myths, legends, short stories, novels), non-fiction (e.g., essays, 
biographies, autobiographies, historical documents), poetry (e.g., epics, 
sonnets, lyric poetry, ballads) and drama (e.g., tragedy, comedy).  

Information Skills Curriculum, Grade 9 
5.03 Describe, support an opinion, and/or persuade an audience using a 
variety of media formats (print, graphical, audio, video, multimedia, web-
based). 

 
Learning Objectives in 
Technology 

NCDPI objectives 
 
Computer/Technology Skills Curriculum, Grades 9-12 
3.3 Select and use technological tools for class assignments, projects, and 
presentations.  
 

Instructions: In this lesson, students will be examining plot by applying the concept of 
plot to the story they just read, “The Lady, or the Tiger?” They will also 
learn about plot by referring to the stories they read last week, “The Most 
Dangerous Game” and “The Cask of Amontillado.” In large part, this 
should be a review of the concept of plot learned in earlier language arts 
courses, but this will be a new application of the concept of plot to the 
stories for this unit.  Once the concept of plot is reviewed, students will 
break into groups to finish the plot for the story “The Lady, or the Tiger?” 
as the story ends where the climax of the plot should be.  In creating their 
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own ending, students will be working to persuade others that their ending 
is the most likely ending for the story, based on evidence contained in the 
story.  
 
First part of class, approximately 20/25 minutes: 
 
Remind students that during the previous class, they read the short story, 
“The Lady, or the Tiger.”  During this class, review the highlights of this 
story with the class.  To discuss the story, have students move into a 
circle. Use the following questions to facilitate the discussion, adding 
more if you wish: 

1. What happens to someone accused of a crime in this particular 
kingdom? 

2. Why do people in the community support this method of 
punishment?  Is it fair?  Why or why not?  Is this any different 
from flipping a coin? 

3. What crime is the young man in the story accused of committing?  
Why were his actions considered a crime?  In your opinion, is 
loving someone a crime? 

4. Describe the actions of the young man and the princess in the 
arena.  Does he trust her?  Explain. 

5. What does the princess know about the lady?   
6. What might motivate the princess to send the young man to his 

death?  Why might she save him?  Why is it important that she is 
described as semi-barbaric as opposed to barbaric? 

 
Middle of class, approximately 30/35 minutes: 
While in the circle, pass to the students the Plot handout. Explain that 
most stories tell us what happens to the main characters; for 
example/review: 

1. What happens to Rainsford in “The Most Dangerous Game” and 
Fortunato in “The Cask of Amontillado.” 

2. Do these stories have some sort of “high point” and some sort of 
“conclusion?” 

3. What should/is the high point of the story, “The Lady, or the 
Tiger?” 

 
Review the concept of plot with the students referring to the plot handout.  
Fill in one or two things that happen at each point of the plot in each of 
these short stories.   
 
Students will note that with the story, “The Lady or the Tiger,” the story 
ends at the climax.  The question the climax (the emotional high point of 
the story) should have answered would logically be the result of what 
came out of the door.  But the author doesn’t tell us what came out of the 
door, so he leaves it to us to decide!  Explain to students that since the 
decision is up to us, students will work in groups to decide what the 
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climax of the story should be, and why.  Each group will not only have to 
provide the ending of the story, but they must persuade the rest of us that 
their opinion of the ending is the likely one, and that they will do this by 
creating a PowerPoint presentation that they will share with the class 
during the next class period.  
 
Divide class into groups of 3 or 4 students, creating 5 or 6 groups for the 
class (keeping in mind you have a total of 6 machines if necessary, as one 
group could use the instructor’s machine). 
 
Each group should be given one of the “The Lady, or the Tiger?” 
handouts (at end of this document).   
 
Remainder of class, approximately 40/50 minutes: 
Students work in groups to form an opinion of the climax of the story, 
following the directions in the “The Lady, or the Tiger?”  handout in 
order to complete their PowerPoint presentations.  They can refer to the 
Microsoft Office Handbook that has information on using PowerPoint if 
this guide is needed, and the guide for using Microsoft’s Online Clip Art 
Gallery, if needed.  As the students have used PowerPoint prior to this 
activity in earlier units in the course, no major problems are anticipated.  
Most of their work should center on deciding the climax of the plot, and 
in justifying their decision. 
 
Next class session (s): 
Each group will present their PowerPoint presentation to the class, and 
their presentation AND the content contained within will comprise their 
grade. 

Evaluation of Subject Area 
One 
[Language Arts, English I] 

The instructor will note the verbal responses made by the class in the 
initial discussion to check for understanding of the concept of plot, and 
will see how well the students are able to apply this concept to earlier 
stories that they have read.  The instructor will personally reflect on the 
success of the lesson:  did the class seem engaged in the content?  Were 
their responses appropriate?  Meaningful?  Did they indicate depth of 
understanding?  Did the groups seem engaged in working together to 
provide a climax to the story as required?  Was their opinion supported, as 
noted on the rubric? 
 

Evaluation of Subject Area 
Two 
[Information Skills, Grade 
9] 
 

Was the group’s PowerPoint appropriate to the audience and purpose?  
Was the group able to describe and support an opinion?  Was their 
presentation persuasive? This is graded on the rubric. 

Evaluation of Technology 
Integration:  

Learning to utilize multimedia software, such as PowerPoint, is an 
expected skill for students.  The handout asks for some specific items to 
be included in the PowerPoint presentation, and the groups will be graded 
on their inclusion and their presentation. 
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Credits Images are from the Microsoft Clip Art Gallery Online  
(http://dgl.microsoft.com/)  
 
Teacher’s Wraparound Edition Glencoe Literature, The Reader’s Choice, 
Course 4, published by Glencoe McGraw-Hill, New York: 2000. (For 
information on plot and good questions to ask for this short story) 
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Plot 
PLOT:  The sequence of events in a story, each event causing or leading to the next event.  Plot is 
often created through conflict, a struggle between opposing characters (or a struggle between the 
character and some force, such as nature, or something internal, such as a struggle to make a decision). 
 
External conflict:  one between a character and an outside force, such as another character, nature, 
society, or fate 
Internal conflict:  takes place within the mind of a character who is torn between opposing feelings or 
between different courses of action 
 
Most plots develop in 5 stages: 

1. Exposition:  introduces the story’s characters, setting and conflict. 
2. Rising action:  occurs as complications, twists, or intensifications of the conflict occur. 
3. Climax:  the emotional high point of the story. 
4. Falling action:  the logical result of the climax. 
5. Resolution:  the final outcome of the story. 

 
There is a 6th stage of plot in some stories: 

6. Denouement:  after the final outcome of the story, further information, a footnote, some other 
information that adds to the story 

 
The Cask of Amontillado 
Exposition Rising Action Climax Falling Action Resolution 
     

The Most Dangerous Game 
Exposition Rising Action Climax Falling Action Resolution 
 
 
 
 
 

    

The Lady, or the Tiger 
Exposition Rising Action Climax Falling Action Resolution 
 
 
 
 
 
 

    



ECI 511, Donna Petherbridge, Comprehensive Unit Plan 

 18

 

“The Lady, or the Tiger?” - PLOT 
 
”And so I leave it with you: Which came out of the opened door ”And so I leave it with you: Which came out of the opened door ”And so I leave it with you: Which came out of the opened door ”And so I leave it with you: Which came out of the opened door –––– the lady, or the tig the lady, or the tig the lady, or the tig the lady, or the tiger?” er?” er?” er?” –––– Frank Stockton Frank Stockton Frank Stockton Frank Stockton    
 
As part of developing our understanding of the concept of PLOT, you will work in groups to write the climax 
(the highest point of emotional interest) for Frank Stockton’s short story, “The Lady, or the Tiger.”  Not only 
will you decide what came out of the door, you will support this opinion with clear evidence from the story! 
 
 You will be creating a PowerPoint presentation, which you will share with the class, to show us what your 
group believes was behind the door the young man was directed to open by the princess.  By following the 
directions on this handout carefully, you will be well on your way to creating an excellent presentation that 
provides an informed opinion on what you believe came out of that door!  
 
Directions: 

1. Decide on a group name, and tell the instructor what your group name will be. Your group name is: 
_________________. 
 

2. With your group, decide on what was behind that door, the lady, or the tiger?  You will have to discuss 
this until your group comes to a consensus!!  Majority rules if there is no consensus!  Then, find at least 
6 clear pieces of evidence in the text that will support your group’s opinion.  Use this chart to help your 
group with this activity: 

 
 
 

In the opinion of your group, 
what came out of the door? 

 
 
 
 
 

Evidence 1:  
 
 

Evidence 2:  
 

 
 
 

Evidence 3:   
 
 

Evidence 4:  
 
 

Evidence 5:  
 
 

Evidence 6:   
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3. Now, use this information to create a PowerPoint slide show that presents your climax to the story AND 
provides the evidence that you are presenting that backs up your choice.  Your slide show MUST 
include the following:  

 
a) A title slide with the phrase “The Lady, or the Tiger?” What came out of the door? 
b) A slide that gives your “group name” and the names of each person in your group. 
c) A slide that indicates your group’s decision for what came out of the door. 
d) One slide must be included for each of the six pieces of evidence that you are referring to that 

support your opinion for what came out of the door. Keep in mind that in a PowerPoint presentation, 
you need not write out long responses to the questions.  Instead, keep the points brief, YET BE 
PREPARED to expand on these points during your presentation to the class!!! 

e) A final slide with the word “Questions?” (This will be the slide you stop on at the end of your 
presentation to give your classmates a chance to ask questions of your group). 

f) Each slide, including the title slide, group name slide, the slides that respond to the questions, and 
final/questions slide should include one Clip Art that is appropriate for your presentation. 

g) Use any of the PowerPoint templates that your group wishes to use. 
h) Make sure that you use appropriate text and font sizes. 
i) Use at least one bulleted list somewhere in your presentation. 
j) Use a transition between your slides – your group can pick the transition. 
k) Use at least one animation. 

 
 

4. When you are finished, please save your PowerPoint slide show to the disk the instructor has given to 
you.   

a. File > Save a Copy As 
b. For your file name, please use your group name. 
c. Write your group name, and the names of each person in your group, on the disk label. 
d.  Turn the disk into your instructor. 

 
 



ECI 511, Donna Petherbridge, Comprehensive Unit Plan 

 20

Evaluation Rubric for “The Lady, or the Tiger” activities 
 
“But how much oftener had she seen him at the other door!” – Frank Stockton, from “The Lady, or the Tiger?” 
 
Group Members:    ___________________ 

___________________ 
___________________ 
___________________ 

 
 

100 possible points  Total 
Possible 

Your 
Score 

You have a title slide with the phrase “The Lady, or the Tiger?” 
What came out of the door? 
 

5  

You have a slide that includes your group name AND the names 
of each person in your group. 

5  

You have a slide that indicates what your group believes came 
out of the door.   

5  

You have a slide for each piece of evidence that supports your 
group’s conclusion for what came out of the door.  There should 
be at least 6 slides, each one detailing a piece of evidence that 
led your group to its decision.  

60  

You’ve provided a Questions slide. 5  
You’ve done the following in utilizing the PowerPoint software. 
! Appropriate font sizes and text 
! One bulleted list 
! One graphic per slide 
! Use of transitions between slides 
! At least one animation 

10  

Your group presentation demonstrated organization and clearly 
supported your groups’ opinion regarding what came out of the 
door.  You were able to explain in further detail your slides, and 
you were able to respond effectively to your classmates’ 
questions about your character.  You were very persuasive in 
presenting your belief as to what was behind the door. 
 

10  

 Total Score: 
Comments: 
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Guide for using the Microsoft Design Gallery Live  
(http://dgl.microsoft.com/) 
 
Use this as a reference for inserting Clip Art from the Microsoft Design Gallery Live into your 
PowerPoint presentation. 
 
You’ll need: 

- Microsoft PowerPoint 2000 
- A connection to the Internet 

 
With your document open in Microsoft PowerPoint: 
 

1. From the Insert Menu, select Picture, then Clip Art. 
 

2. Click on the Clips Online tab. 
 

3. If you are asked if you have access online, click on OK.  You may not receive this prompt 
every time. 
 

4. You will connect to the Microsoft Design Gallery Live web page.  Once on this page, use the 
Search fields (on the left hand side of your screen) to find what you are looking for.  You can 
type in a word in the search field, then click on the Go button to perform your search.  As you 
become comfortable using the search function, you can filter your search by category. 
 

5. Once you have performed your search, images should appear that match your search.  To 
download and use in your document, you can click on the download graphic (a red arrow 
over a gray bar). 
 

6. Your graphic will then appear in the Insert Clip Art menu.  To finish inserting the Clip Art, 
click once on the clip art, and the Insert Clip Art menu will appear.  Click on this menu to 
insert. 
 

7. Your selected Clip Art should appear in your document.  You may click on the Clip Art to 
resize it, and/or use the Format > Picture menu to make other changes. 
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Language Arts 
 
 
 
 
 
 
 

Curriculum Area(s) English Language Arts  
Social Studies 

Subject Area(s) English I 
Psychology 
9-12 Computer Technology Skills 

Week’s Theme Week Three:  Filling a Void 
These stories focus on characters that find something missing in their 
lives.  They try to compensate for the emptiness or loss, finding their lives 
affected by the choices they make in attempting to fill in the void. 
 

Lesson Title “The Secret Life of Walter Mitty” –One More Daydream! 

Suggested Grade Level English I, Grade 9 

Time 90 minutes (possible in one class session with block schedule) 
Equipment Needed and 
Availability 

! Teaching computer, projector to project the information on the 
instructor computer 

! 5 additional computer stations in the classroom  
! Computers have floppy disk drives 
! All computers have Microsoft Word, an Internet browser, and are 

able to read PDF files (as one of the links on the Curriculum 
Guide is to a PDF file). 

! Computers should have Internet access. 
! “The Secret Life of Walter Mitty” handout 
! “The Secret Life of Walter Mitty” evaluation rubric 
! Microsoft Design Gallery Live handout (simply a review from 

previous sessions, focusing on the use of Clip Art in Word instead 
of in PowerPoint) 

! “The Secret Life of Walter Mitty” Curriculum Guide pre-made by 
instructor and loaded on instructor’s machine AND available at all 
machines for student groups.  It may be useful to also make this 
page available a as a handout if there are students who may prefer 
directions this way. This web page is part of this lesson plan (see 
end of lesson plan).  To use as a web page, the instructor should 
save the Word page as a Web Page, using Word. 

! One disk, with a blank label, is needed for each group. 



ECI 511, Donna Petherbridge, Comprehensive Unit Plan 

 23

Prerequisite Skills in 
Subject Area One 
[Language Arts, English I] 

Students are halfway in their short story journey, and have studied 
characterization and plot in earlier stories.  Students should have 
completed reading “The Secret Life of Walter Mitty” for today’s lesson, 
and be prepared to discuss it.  
 
 

Prerequisite Skills in 
Subject Area Two 
[Psychology] 

Students do not necessarily need to have any “formal” psychology 
classes.  However, at this age level, students can be expected to relate to 
daydreaming as a way to handle stress and/or boredom, as does the main 
character in this short story, Walter Mitty.  

Prerequisite Skills in 
Technology: 

Students have already spent time using the computer for earlier 
assignments for this unit working with Microsoft Excel and PowerPoint in 
their various groups and should be comfortable in working in small 
groups on the computer.  They have inserted Clip Art into their 
PowerPoint presentation, so are familiar with this skill. 

 
Learning Objectives in 
Subject Area (s) [Language 
Arts and Social Studies] 

NCDPI objectives 
 
Language Arts, English I 
1.01 Narrate personal experiences that offer an audience vivid 
impressions of being in a setting and a sense of engagement in the events 
occurring. 
  
Social Studies, Psychology 
6.02 Explore psychological and physiological reactions to stress. 

 
Learning Objectives in 
Technology 

NCDPI objectives 
 
Computer/Technology Skills Curriculum, Grades 9-12 
3.2 Use electronic resources for research. 
 

Instructions: In this lesson, students will discuss the short story, “The Secret Life of 
Walter Mitty,” and learn about point of view as part of their study of the 
genre of the short story.  As part of the discussion, students will talk about 
daydreaming as a way people fill voids and respond to stress. Then, in 
groups, students will write a new daydream for Walter Mitty, using as the 
catalyst exiting sites found on the Internet!    
 
First part of class, approximately 25/30 minutes: 
 
Have all students move their chairs in a circle to discuss the story.  
Questions to stimulate the discussion include, but aren’t limited to: 

1. What does Walter’s wife ask him to do while she’s at 
the hairdresser? 

2. How does Walter feel about these errands? 
3. Describe Walter’s daydreams.  What is ironic about the 
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daydreams? 
4. Aside from his wife, what other characters scold 

Walter and why?   
5. Why does Walter think the parking attendant is cocky?  

What does that tell us about him? 
6. How does his wife greet him at the hotel?  What does 

their conversation tell us about their relationship? 
7. What is Walter doing at the end of the story, and why? 
8. Did you find any parts of the story especially funny?  

Or sad? 
9. Would you like being married to someone like Walter 

Mitty?  What about Mrs. Mitty? Discuss. 
10. What is the conflict in this story?  How does Walter 

resolve the conflict (or does he?) 
 
Middle of class, approximately 20/25 minutes: 
Have students move their chairs to face the instructor’s station. 
 
Once you have discussed the story’s conflict with the students (e.g. 
Walter’s struggle to avoid his wife’s nagging and controlling, which he 
tries to escape by daydreaming, but invariably this means he is even in 
less control of his life), talk with students about reactions to stress. 
 
In Walter’s life, his nagging wife causes stress.  His psychological 
reaction is to daydream.  Discuss with the students how people react to 
both physical and psychological stress. For exploring this concept, open 
up “The Secret Life of Walter Mitty” Curriculum Guide and follow the 
link that explores this concept of why people daydream. 
 
Distribute the “The Secret Life of Walter Mitty” handout, and discuss 
Point of View (handout at end of this document).   
 
New term: Point of View 
 
Point of view:  the relationship of the narrator to the story. 
1st person point of view:  the narrator is a character in the story, referred to 
as “I” (ex. “American History”, which we will read later this week). 
3rd person limited point of view: the narrator reveals the thoughts, 
feelings, and observations of only one character, referring to that character 
as “he” or “she.” (ex. “The Secret Life of Walter Mitty,” which we just 
read) 
3rd person omniscient point of view (or all-knowing point of view): the 
narrator is not a character in the story, but a character who stands outside 
of the story and comments on the action, and knows everything about the 
characters and the events and may reveal details that the characters 
themselves could not reveal (ex. “The Most Dangerous Game,” one of the 
first stories that we read.) 
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After distributing the handout and introducing the term “point-of-view”, 
let the students know that they will be divided into groups to write a new 
daydream for Walter Mitty.  They should write these daydreams from the 
same point of view that is used in the story, and should narrate these 
experiences in a manner that offers an audience vivid impressions of 
being in a setting and a sense of engagement in the events occurring. 
 
Divide class into groups of 3 or 4 students, creating 5 or 6 groups for the 
class (keeping in mind you have a total of 6 machines if necessary, as one 
group could use the instructor’s machine). 
 
Remainder of class, approximately 50/55 minutes: 
Students work in groups to review their characters, following the 
directions in the “The Secret Life of Walter Mitty” handout AND the 
“The Secret Life of Walter Mitty” Curriculum Guide web site (created by 
the instructor and available as a Word document at the end of this 
handout) in order to complete their assignment. They can refer to the 
Microsoft Office Handbook that has information on using Microsoft 
Word if this guide is needed, and the guide for using Microsoft’s Online 
Clip Art Gallery, if needed, both of which they used for earlier 
assignments.   
 
Next class session (s): 
The class will share and discuss the group’s daydreams for Walter. 

Evaluation of Subject Area 
One 
[Language Arts, English I] 

The instructor will note the verbal responses made by the class in the 
initial discussion to check that students have read and understand the 
story.   The instructor will evaluate the student groups’ daydreams for 
their vividness and sense of engagement, and correct point of view.  See 
rubric. 
 

Evaluation of Subject Area 
Two 
[Psychology] 
 

The instructor will note the students’ responses to how psychological 
stress is handled.  Also, see rubric for evaluation of daydream, as a vivid 
daydream is certainly one reaction to stress and how characters/people fill 
voids in their lives. 

Evaluation of Technology 
Integration:  

Did students enjoy using the web to assist then with this assignment, in 
comparison with past classes that have used only a handout from the 
teacher, having been asked to simply write a daydream?  Did linking to 
the daydream “catalysts” on the Internet seem to help them with writing 
the daydream?  Did they describe the catalyst well in their daydream (see 
rubric). 
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Credits Images are from the Microsoft Clip Art Gallery Online  
(http://dgl.microsoft.com/)  
 
Teacher’s Wraparound Edition Glencoe Literature, The Reader’s Choice, 
Course 4, published by Glencoe McGraw-Hill, New York: 2000. (For 
information on point of view and good questions to ask for this short 
story) 
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 “The Secret Life of Walter Mitty” Handout 
 
”Captain Walter Mitty stood up and strapped on his huge Webley-Vickers automatic. 
“It’s forty kilometers through hell, sir,” said the sergeant.” – from “The Secret Life 
of Walter Mitty,” by James Thurber. 
 

Point of View 
Point of view:  the relationship of the narrator to the story. 
1st person point of view:  the narrator is a character in the story, referred to as “I” (ex. “American 
History”, we will read later this week). 
 
3rd person limited point of view: the narrator reveals the thoughts, feelings, and observations of only 
one character, referring to that character as “he” or “she.” (ex. “The Secret Life of Walter Mitty,” which 
we just read). 
 
3rd person omniscient point of view (or all-knowing point of view): the narrator is not a character in the 
story, but a character who stands outside of the story and comments on the action, and knows 
everything about the characters and the events and may reveal details that the characters themselves 
could not reveal (ex. “The Most Dangerous Game,” one of the first stories that we read). 
 
Directions: 
Everyone daydreams, yet Walter Mitty, ineffectual in dealing with his own life, is awash in fantasies, 
daydreaming that he is an awe-inspiring and universally admired figure!  Walter Mitty’s daydreams are 
triggered by something that he SEES or by another character’s words.  Using the web page that has 
been created for this assignment, your group will visit places that Walter Mitty might find could trigger 
an exciting daydream for him.  Your group’s job will be to examine these sites, and pick one that you 
would like to use as the catalyst for Walter’s daydream.  Then, you will write your daydream.  Please 
refer to the web page for further directions.  Your instructor will help you access the web page! 
  

1. Decide on a group name, and tell the instructor what your group name will be. Your group name is: 
_________________. 
 

2. Open Microsoft Word.  You will use Microsoft Word for your response to today’s work. 
3. Open today’s Curriculum Guide, “The Secret Life of Walter Mitty” Curriculum Guide web page.  This is 

a web page your instructor has created for you to help you with today’s assignment.  Your instructor 
will tell you where to find this page. 

4. Carefully follow the directions on the “The Secret Life of Walter Mitty” Curriculum Guide web page to 
complete your assignment!  The directions for successfully completing the remainder of the assignment 
can be found on this guide! 
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“The Secret Life of Walter Mitty”  

Curriculum Guide 
 
Everyone daydreams, yet Walter Mitty, ineffectual in dealing with his own life, is awash in fantasies, 
daydreaming that he is an awe-inspiring and universally admired figure!   
 
As a Class: 
People react in various ways to psychological stress and conflict.  In “filling a void” in their lives, 
people often daydream, as does our main character, Walter Mitty.  We can explore examine this site to 
learn more about why people daydream: 
 
Description URL of Web Site 
Everyone’s a Dreamer, Daydreaming and 
Mental Health 

http://www.gunn.palo-
alto.ca.us/~ckuiper/oracle/June/Page67.pdf  

 
 
WARNING: If you are found on any other site besides those referenced in the assignment, you will be asked to 
sit away from the workstation and you will have a zero for today's assignment. Sorry, but you may not use this 
time to improve your solitaire or immerse yourself in the joys of Internet surfing. Thank you for your kind 
cooperation! 
 
 
What triggers Walter’s Daydreams? 
Walter Mitty’s daydreams are triggered by something that he SEES or by another character’s words.   
In this assignment, your group is going to create a new daydream for Walter, triggered by something that he 
might potentially “see.”  To do this, your group will follow the links to sites that could potentially be catalysts 
for Walter’s new daydream.  You will pick ONE of these sites that will serve as the trigger for the daydream.  
 
Vocabulary Helper 
Can’t remember what “catalyst” means or need to look up other words as you work on this project?  See Miriam 
Webster’s Dictionary online, located at: http://www.miriamwebster.com/.  
 
Step One:  Explore these sites.  As a group, decide which site will serve as the trigger for Walter’s latest 
daydream. 
 
Potential daydream triggers: 
Description URL of Web Site 
The New York Yankees Stadium – just imagine what 
Walter might do if he envisioned himself as a star player in this 
ballpark!  Explore this site to learn about the ballpark and the team.

http://newyork.yankees.mlb.com 
/NASApp/mlb/nyy/ballpark/nyy_ballpark_history.jsp  

The Tower of London – explore this website to learn about 
the history of this place, where Anne Boleyn was beheaded and 
many prisoners executed! What if Walter visited this place? 

http://www.tower-of-london.com/index2.html  

The Eiffel Tower – explore this website for a virtual tour of 
the Eiffel tower, considered a romantic site in Paris.  If Walter 
walked by here . . . 

http://www.tour-eiffel.fr/teiffel/uk/   

USS North Carolina Battleship Memorial – learn 
about the battleship USS NC, what if Walter visited here? 

http://www.battleshipnc.com/ 
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The Titanic Official archive – relics from this sunken 
ship are now touring museums, what if Walter went to this kind of 
display?  

http://www.titanic-online.com/titanic/index.html  

The San Diego Zoo – all kinds of adventures could ensue 
for Walter were he to visit a Zoo 

http://www.sandiegozoo.org/ 
 

 
Step Two:  Pre-write/Brainstorm.  Open a new copy of Microsoft Word on your group’s workstation.  Make a 
list of the different events that come to your mind about what Walter might do in this particular setting.  
Brainstorm for names of other characters that also could be involved in this daydream.  Begin planning with 
your group how Walter’s daydream in this setting might evolve.  Label your brainstorming session as 
Prewriting in your Word document. 
 
Step Three:  Save Your Work and Identify Your Group. Go ahead and type in the name of your group, and 
the names of your group members in your Word document.  Save your work to your disk as 
name_of_group.doc. 
 
Step Four:  Write a New Daydream for Walter.  In writing your daydream, refer back to the daydreams in the 
story.  Your daydream MUST do the following: 

1. Must be triggered by the site that your group decided upon, and must clearly describe that site as the 
catalyst for the daydream. 

2. Have at least two other new characters besides Walter in the daydream (you invent these characters, as 
he invents them in his daydreams in the story). 

3. Offer the audience vivid impressions of the setting. 
4. Offer the audience a sense of engagement with the events occurring (in other words, really describe the 

action and build the events so that the audience is caught up in the action, much as the reader is for the 
daydreams in the story). 

5. Should be humorous, in the same manner as the daydreams in the short story, clearly differentiating the 
“real” Walter Mitty from the “daydream” Walter Mitty. 

6. Should be grammatically correct. 
See the rubric for how this assignment will be graded! 
 

Step Five:  Save Your Work Again!  It never hurts to keep saving your work! 
 
Step Six:  Add an Image to your work.  Insert at least one Clip Art image into your work that helps illustrate 
your daydream.  OR be adventurous, and download and use an image from the website that serves as the 
catalyst for your dream    
 
Step Seven:  Credits.  Provide the URL of the site that you chose for your catalyst.  If you downloaded images 
from that site to use in your Word document, please indicate that in your credits.  For an example, see the 
Credits/References section at the bottom of this web page! 
 
Step Eight:  Save Your Work, Again, and Turn In! Make sure that your work is saved on your disk! Turn in 
your disk to the instructor. Write your group members' names on the label of the disk. 

 
 

 
Credits/References: 
The Caution Graphic is from http://www.clipart.com. 
Other Graphics are from the Microsoft Clip Art Gallery located at http://dgl.microsoft.com/. 
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Evaluation Rubric for  
“The Secret Life of Walter Mitty” activities 
 
“He took one last drag on his cigarette and snapped it away.  Then, with that faint, fleeting  
smile playing about his lips, he faced the firing squad; erect and motionless, proud and  
disdainful, Walter Mitty the Undefeatable, inscrutable to the last.” – James Thurber,  
from “The Secret Life of Walter Mitty.” 
 

Group Members:    ___________________ 
___________________ 
___________________ 
___________________ 

 
100 possible points  Total 

Possible 
Your 
Score 

You chose a catalyst for Walter’s new daydream and have 
clearly described this catalyst in your writing 

10  

You have two other new characters involved in Walter’s 
daydream 

10  

You completed the prewriting activities. 10  

Your daydream vividly illustrates the setting. 15  

Your daydream provides the audience with a sense of 
engagement with the daydream  

15  

Your daydream is original and clever AND uses the 3rd person 
limited point of view 

15  

Your daydream is humorous 10  

The names of your group members, the name of your group, and 
one image are evident in the assignment you turn in. 

5  

Mechanics 
! Your work is neat and attractive 
! Sentence structure is good 
! Spelling is accurate 
! Punctuation is correct 
! Verbs used correctly 

10  
 
 
 
 
 

Comments: 
 
 
 
 
 

Total: 
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Guide for using the Microsoft Design Gallery Live  
(http://dgl.microsoft.com/) 
 
Use this as a reference for inserting Clip Art from the Microsoft Design Gallery Live into your 
Personality Profile. 
 
You’ll need: 

- Microsoft Word 2000 
- A connection to the Internet 

 
With your document open in Microsoft Word: 
 

8. From the Insert Menu, select Picture, then Clip Art. 
 

9. Click on the Clips Online tab. 
 

10. If you are asked if you have access online, click on OK.  You may not receive this prompt 
every time. 
 

11. You will connect to the Microsoft Design Gallery Live web page.  Once on this page, use the 
Search fields (on the left hand side of your screen) to find what you are looking for.  You can 
type in a word in the search field, then click on the Go button to perform your search.  As you 
become comfortable using the search function, you can filter your search by category. 
 

12. Once you have performed your search, images should appear that match your search.  To 
download and use in your document, you can click on the download graphic (a red arrow 
over a gray bar). 
 

13. Your graphic will then appear in the Insert Clip Art menu.  To finish inserting the Clip Art, 
click once on the clip art, and the Insert Clip Art menu will appear.  Click on this menu to 
insert. 
 

14. Your selected Clip Art should appear in your document.  You may click on the Clip Art to 
resize it, and/or use the Format > Picture menu to make other changes. 
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Language Arts 

Curriculum 
Area(s) 

English Language Arts  
Information Skills 

Subject Area(s) English I 
Information Skills Grade 9 
9-12 Computer Technology Skills 
 

Week’s Theme Week Four: A Death in the Family 
These stories focus on characters dealing with the death of a family member. 
 

Lesson Title Writing about Theme:  “The Scarlet Ibis”  
 

Suggested Grade 
Level 

English I, 9th Grade 

Time 90 minutes (possible in one class session with block schedule) 
Equipment 
Needed and 
Availability 

! Teaching computer, and projector to project the information on the 
instructor computer 

! SCHEDULE the computer lab, so that EACH STUDENT has access 
to a computer for the writing part of class 

! Prior to taking class into the computer lab, ensure that the Microsoft 
Word software is working and that students can connect to the  
Microsoft Design Gallery Live (http://dgl.microsoft.com/) 

! Guide for using the Microsoft Design Gallery Live – A handout used 
for an assignment for “Walter Mitty,” refer back to this handout 

! Ensure that the printer in the computer lab is working 
! Pre-made Microsoft Word document at teacher’s station with headings 

for the Literary Analysis in class (see instructions area) 
! Microsoft Office Handbook that has information on using Word is 

available as a reference in the lab as needed 
! Literary Analysis handout (at end of lesson plan) 
! Grading Rubric (at end of the lesson plan) 
! Disk for each student for computer lab 
 

Prerequisite 
Skills in Subject 
Area One 
[Language Arts, 

Students are in the fourth week of the unit on Short Stories.  They have 
completed reading all previous week’s stories, and this week’s stories, 
“Before the End of Summer” and “The Scarlet Ibis.”  Each week’s lesson has 
built on an understanding of what the genre of short story is, and students 
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English I) have examined setting and characterization, point of view, plot and they have 
a beginning understanding of theme, as it has been mentioned for the earlier 
stories. They have discussed “Before the End of Summer” in complete detail, 
and the “The Scarlet Ibis” in terms of characters, setting, point of view and 
plot, which are the short story elements they have been building on over this 
unit, and with these stories, they have begun to discuss theme, which they 
have done for “Before the End of Summer,” and will do in class today for 
“The Scarlet Ibis.”  

Prerequisite 
Skills in Subject 
Area Two 
[Information 
Skills Grade 9] 

As ninth graders, students will be building on earlier skills in using and 
organizing information.  They have organized information previously, for 
example, in week three of the short story unit, they organized information for 
a web page. 

Prerequisite 
Skills in 
Technology: 

Students have already spent time using the computer for earlier assignments 
that have addressed the following skills: 

- Typing, editing and formatting text in Microsoft Word 
- Inserting Clip Art into Word documents using the Microsoft Design 

Gallery Live (assignment from “The Secret Life of Walter Mitty.” 
 

 
Learning 
Objectives in 
Subject Area (s) 
[Language Arts 
and Information 
Skills Grade 9] 

NCDPI objectives 
 
Language Arts, English I 
5.01 Read and analyze various literary works by explaining and interpreting 
archetypal characters, themes, and settings. 
 
Information Skills Grade 9 
4.07 Organize and use information. 
 

Learning 
Objectives in 
Technology: 

NCDPI objectives 
 
Computer/Technology Skills Curriculum, Grades 9-12 
3.1 Use word processing and/or desktop publishing for a variety of writing 
assignments/projects. 
 

Instructions: In this lesson, students will be challenged to find themes in the short stories 
that have been read from this unit.  The short story “The Scarlet Ibis” will be 
examined for theme(s) as an example, then, students will choose a story from 
this unit to write a paper about theme. 
 
Beginning of class, approximately 20/30 minutes: 
 
Review “The Scarlet Ibis,” answering the following questions: 
 

1. Recall the two main characters (brother & Doodle). 
2. Is the narrator (Brother) in any way responsible for Doodle’s death?  

Why or why not? 
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3. In what ways does Brother love Doodle?  In what ways is he cruel? 
 
Then, review the meaning of “theme.” 
Theme:  central message or insight into life revealed through the literary 
work.  It is NOT a condensed summary of the plot; instead, it is a 
generalization about human beings or the human condition. 
 
Class should face the area of the room with the instructor’s projected 
machine. 
 
While projecting the computer’s information to a screen all students can see, 
open a pre-made Microsoft Word document that has the following headings: 
 
Generate a list of topics for The Scarlet Ibis 
[Examples: Pride, rites of passage, sibling rivalry] 
 
What did the author believe about these topics? 
[Example:  pride can be good and bad] 
 
What evidence does the author give to support this theme? 
[Example:  The narrator’s pride means that he helps his brother do things he 
couldn’t do before [good – he taught him to walk].  But that same pride meant 
he overtaxed Doodle, and may have contributed to his death [bad]. 
 
Formulate a thesis statement  
[Example: Pride is both a wonderful and terrible thing, as shown by the 
actions of Brother towards Doodle in “The Scarlet Ibis.”] 
 
Give the students the Literary Analysis handout and the grading rubric (see 
end of lesson).  Review the assignment with them [stated on the handout] and 
take them to the computing lab.   
 
Remainder of class, approximately 60/70 minutes: 
In the computer lab, have students open a new copy of Microsoft Word, and 
hand them each a disk.  Explain that they should save their work to the disk so 
that they can easily edit and rewrite later drafts.  They should save their work 
as “theirname_ssanalysis.doc”. 
 
Work with students to brainstorm ideas, using Word and following the 
Literary Analysis Paper Guidelines.  They may write their analysis on any 
story read so far for the short story unit. 
 
They should spend the time in the lab working on their papers.  When they 
finish, they should save a copy to their disk, and print out a copy, and turn in 
both the disk and the paper copy.  If they do not finish, they will be able to 
use the computer lab again to finish their papers over the next class period, or 
take them home and finish them.  If they do finish early, they can begin 
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reading the next story in the series, “Uncle Marcos.” 
 
Next class session (s): 
The students will read the short story “Uncle Marcos” [individually] and 
answer some questions about this story that help bring together everything 
they have learned about the genre of the short story.  The computer lab will 
also be scheduled so they can finish their papers as needed, in case they 
cannot work on them at home.  If they choose to work on their papers in class, 
then reading the story and completing questions for the story will be 
homework. 
 

Evaluation of 
Subject Area One 
[Language Arts, 
English I] 

The instructor will note the verbal responses made by the class in the initial 
discussion to check for understanding of theme. The rubric also serves to 
grade the students’ work (can they explain and interpret the theme, thus 
meeting the objective). 

Evaluation of 
Subject Area 
Two 
[Information 
Skills Grade 9] 

The instructor will grade, through the rubric, the students’ abilities to organize 
and use information from their literary analysis. 
 

Evaluation of 
Technology 
Integration: 

Are the students able to use Microsoft Word to type their paper?  Can they 
follow the conventions/expectations outlined in the handout? 
 

Credits Some questions came from the Annotated Teacher’s Edition Prentice Hall 
Literature Gold, published by Prentice Hall, 1996, Upper Saddle River, New 
Jersey.   
 
Thanks to Judy Darling, for her ideas for a literary analysis paper. 
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Literary Analysis Paper –  
Determining the Author’s Theme 
 
Rationale: 
Literature allows us to vicariously experience a variety of human dilemmas.  Through reading we 
discover the consequences of choice and the rewards of wise behavior.  But skillful authors rarely 
present their insights about the human condition in an explicit manner.  Rather, we are to enjoy the 
writer’s craft as we search for clues as to what the author believes about life. 
 
Assignment:  You are to write an essay in which you state the author’s theme and prove that theme 
with evidence from the text.  Your thesis should express the theme and explain how the author conveys 
that theme.  Keep in mind; your task is to analyze not just what the author believes but how he makes 
that belief clear to the reader.  The author may have used characterization, setting, plot sequence, a 
system of symbols, point of view or narrator, imagery, or a combination to make his beliefs somewhat 
clear to the reader. 
 
Procedure:  As was done in class, generate a list of topics from the literature [you may do all of the 
brainstorming activities on your computer!!!]: 
 
 
 
From this list, choose two or three that are more predominant in the story.  Determine what the 
author believed regarding these issues or topics.  Experiment with several themes for each topic.  As 
you compose the theme, decide if there is enough evidence in the literature to support it. 
 
 
 
Now, choose the best theme and determine how the author makes that theme clear either throughout 
the work, or in one chosen or pre-assigned passage.  List the supporting proofs. 
 
 
Finally, formulate a thesis statement that states the author’s theme and the methods he used to 
convey that theme to the reader.  This is your statement that you believe to be true and that you intend 
to support in your paper.  Write your thesis here: 
 
 
Your paper should be a minimum 2 – 3 pages typed and double-spaced in 12 point Times New Roman 
font.  One-inch margins on sides, top, and bottom.  Page numbers centered at the bottom, including 
first page.  Cover sheet with title centered and name, date, class.  [Bracket in your thesis statement like 
this.]  Insert at least one clip art graphic to bring visual appeal to your paper! 
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Rubric for Literary Analysis of Author’s Theme 
Possible score:  100 points 
 
Your Analysis 
_____  (15) Thesis is sound, complex and requires proof.  It states the author’s theme and your 
evidence of how he conveys that theme. 
 
_____  (15) Arguments are clearly stated at the beginning of each paragraph or section of the paper. 
Statements are logical and sound.  The relationship between thesis and argument is obvious. 
 
______  (20) Proofs are thorough and convincing.  Cause and effect statements are rational, examples 
are relevant, and definitions are concise and pertinent.  Comparisons and contrasts are clearly stated.  
The relationship between proof and argument is obvious.   
 
______  (10) Introduction is lively and catches the reader’s attention. 
 
______  (10) Conclusion is concise and new, and closes with a strong statement that leaves the reader 
with a strong, lasting impression. 
 
Mechanics and style (1 point each) 
_____ You include at least one clip art graphic 
_____ Spelling is flawless 
_____ Literary present tense is used throughout.  Verbs are used correctly and the tense does not shift.  
_____ Subject and verb agree in number. 
_____ Pronouns are used correctly and antecedents agree. 
_____ Sentence structure is strong; no awkward phrasing. 
_____ Prepositions are used accurately and modifiers are accurate and well-placed. 
_____ Punctuation is correct. 
_____ Diction is appropriate.  The right word is used and colloquialisms are avoided.  A formal 
academic tone is maintained throughout. 
_____ Proper documentation is followed. 
 
Following Directions (10 points) 
_____ Minimum 2 – 3 pages typed and double-spaced in 12 point Times New Roman font.  One-inch 
margins on sides, top, and bottom.  Page numbers centered at the bottom, including first page.  Cover 
sheet with title centered and name, date, class.  [Bracket in your thesis statement like this.]  
 
______ Total Score 
 
Overall Comments: 
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Language Arts 
 

Curriculum 
Area(s) 

English Language Arts  
Information Skills 

Subject Area(s) English I 
Information Skills Grade 9 
9-12 Computer Technology Skills 

Week’s Theme Week Five: Love and Family Relationships 
These stories explore family relationships in the context of love, appreciation, 
and sacrifice. 
 

Lesson Title Short Story Wrap-Up 

Suggested Grade 
Level 

English I, Grade 9 

Time 90 minutes (possible in one class session with block schedule) 
Equipment 
Needed and 
Availability 

! Teaching computer, projector to project the information on the 
instructor computer 

! 5 additional computer stations in the classroom  
! Computers have floppy disk drives 
! All computers have FileMaker Pro and the downloadable guide for 

using FileMakerPro [note: it is possible to substitute Microsoft Office 
2000 Access and the Microsoft Office Handbook, though some 
directions would change in the student handout.] 

! Short Story Wrap-Up handout 
! The instructor should have all short stories already completed for the 

unit noted so that the students can be given titles and page numbers 
quickly once they are in their groups. 

! One disk, with a blank label, is needed for each group. 
! The instructor should create a database for the student groups to enter 

data, using the fields that are on the Short Story Wrap-Up handouts.  
The database should be available on each machine for the students to 
add entries to.  The database should have one sample record for 
students to review (use “The Gift of the Magi”.  A copy of this 
database should be available on each machine.  This database is 
referred to as “shortstories.fp5” in the student handout. 
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Prerequisite 
Skills in Subject 
Area One 
[Language Arts, 
English I] 

Students have completed reading all the stories in their Short Story Unit.  
While studying the short stories, students have developed an understanding of 
characterization [protagonist, antagonist], setting, plot [including 
foreshadowing, exposition, rising action, climax, falling action, resolution, 
denouement, internal conflict, external conflict], point of view [first-person, 
third-person limited, third-person omniscient], and theme [stated and 
implied]. 
 

Prerequisite 
Skills in Subject 
Area Two 
[Information 
Skills, Grade 9] 

As ninth graders, students will be building on earlier skills in using and 
organizing information.  They have organized information for papers they 
have written, for example, the Literary Analysis paper that they did in week 
four of the Short Story Unit.  They’ll also be building on the analysis of the 
stories we have done in the class. 
 

Prerequisite 
Skills in 
Technology: 

Students have already spent time using the computer for earlier assignments 
in the school year that have addressed the following skills: 

- Entering data into a database earlier in the school year with an activity 
where they have entered their personal information into the database 
for a “class portfolio.” 

 
Learning 
Objectives in 
Subject Area (s) 
[Language Arts 
and Information 
Skills] 

NCDPI objectives 
 
Language Arts, English I 
5.01 Read and analyze various literary works by recognizing and analyzing 
the characteristics of literary genres, including fiction (e.g., myths, legends, 
short stories, novels), non-fiction (e.g., essays, biographies, autobiographies, 
historical documents), poetry (e.g., epics, sonnets, lyric poetry, ballads) and 
drama (e.g., tragedy, comedy). 

Information Skills Curriculum, Grade 9 
4.07 Organize and use information. 

 
Learning 
Objectives in 
Technology 

NCDPI objectives 
 
Computer/Technology Skills Curriculum, Grades 9-12 
2.1 Practice and refine knowledge and skills in keyboarding/word 
processing/desktop publishing, spreadsheets, databases, multimedia, and 
telecommunications in preparing classroom assignments and projects. 
 

Instructions: In this lesson, students will be challenged to review the short stories they have 
read for a Short Story Unit, analyzing the short stories to find specific 
elements that are present in the short story genre, and then organizing these 
elements into a database for future use in helping review and study the Short 
Story Unit. The final short story from the Short Story Unit will be reviewed 
and analyzed in the class, then, students will divide in teams to help construct 
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a class database of the short stories read and their elements 
 
First part of class, approximately 30/40 minutes: 
 
Read and discuss the short story “The Gift of the Magi,” which students 
completed reading in class the day previously, and for homework if they did 
not finish in class.  Discuss with all students in a roundtable [chairs in circle 
to promote discussion]. Key questions to respond to include the following: 

1. Which possessions do Jim and Della value the most? 
2. What is Della doing at the beginning of the story? 
3. How does Jim react when he sees Della when he arrives home? 
4. What gifts do the couple give each other? 
5. According to the narrator, who are the magi. 
6. Why is the setting important to the story? 
7. How are Jim and Della characterized? 
8. What are key points in the plot? 
9. What is ironic about their gifts for each other? [Introduce and discuss 

the term irony.] 
10. What could be one of the themes of this story? 
11. What’s the point of view in this story? 

 
Vocabulary 
Irony:  a contrast between appearance and reality; situational irony:  when the 
actual outcome is the opposite of what is expected [e.g. the ending of “The 
Gift of the Magi”], verbal irony: when a person says one thing and means 
another [e.g. when Montresor leads Fortunato to his doom in the vaults, and 
he says, “Come, we will go back ere it is too late.  Your cough” in the earlier 
story read, “The Cask of Amontillado”]. 
 
Middle of class, approximately 10/15 minutes: 
Class should move out of the circle to face the area of the room with the 
instructor’s machine. Instructor should comment that the students have used 
this short story to review many of the terms and concepts that they have 
learned as they read through the Short Story Unit, and they have learned a 
new term, irony, that can be applied to the other stories.  They will now have 
an opportunity to apply and then organize and use this information by doing 
an activity involving reviewing two of the short stories that they have read as 
a class as a group, pulling out information that they will then enter into a 
database for the class to use to review the Short Story Unit prior to the test 
 
While projecting the computer’s information to a screen all students can see, 
explain to each group that they will be given a handout (groups get the same 
handout, with the teacher giving each group the names of the short stories 
they will work to analyze).  Each group will then review the short stories they 
have studied, and enter information about these poems into a database 
template that has already been created, following the directions on the 
handout.  The instructor will then review each group’s work and correct as 
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needed, then combine the group database records into one database, so that 
students can have a report of all the short stories they have studied that will 
help remind them of what the short story is about, who wrote it, and what 
elements of the short story genre the short story uses.  The instructor will hand 
the report out to the students the next class period.  The instructor will demo 
the adding of data to the database to the class using the short story, “The Gift 
of the Magi” as an example.   
 
Divide class into groups of 3 or 4 students, creating 5 groups for the class 
(keeping in mind you have a total of 6 machines if needed, as one group could 
use the instructor’s machine). 
 
Each group should be given the Short Story Wrap-Up handout (at end of this 
document).   
 
Remainder of class, approximately 40/50 minutes: 
Students work in groups to review their assigned short stories and enter the 
information into their database template, utilizing the computers in the 
classroom, referring to either the FilemakerPro guide [or, if you substitute 
Access, the Microsoft Office Handbook that has information on using Access] 
if these guides are needed.  As the students are not creating a new database; 
but rather, filling in a pre-designed template, as they have before in an earlier 
activity, it is anticipated that there will be few problems. 
 
Next class session (s): 
The instructor will give each group feedback on their short story 
analysis/entries in the database via the rubric.  The instructor will combine all 
the group’s entries into one database, and produce a report to share with the 
class.  The class can then use this report for studying for the final Short Story 
Unit test.  The next class period will be review and wrap-up of the unit, prior 
to the unit test.  Wrap up activities can include cross word puzzles, character 
bingo, and other creative games to ensure student motivation for reviewing 
the material. 

Evaluation of 
Subject Area One 
[Language Arts, 
English I] 

The instructor will note the verbal responses made by the class in the initial 
discussion to check for understanding of the key elements of a short story.  
The instructor will personally reflect on the success of the lesson:  did the 
class seem engaged in the content?  Were their responses appropriate?  
Meaningful?  Did they indicate depth of understanding?  Did the groups seem 
engaged in working together to analyze the short stories for entry into a 
database? The instructor will also assign points on the group’s entries in the 
database. 
 

Evaluation of 
Subject Area 
Two 
[Information 
Skills, Grade 9] 

The instructor will note the how the students are able to organize information 
in the database.  Did they find the right information that will be useful to 
study later? The instructor will assign points on the group’s data entries on 
their handout based on items in the rubric. 



ECI 511, Donna Petherbridge, Comprehensive Unit Plan 

 42

 
Evaluation of 
Technology 
Integration: 

Learning to utilize Filemaker Pro, Microsoft Access, or another database 
appropriately for projects is a necessary skill for students.  The instructor will 
note the students’ effectiveness in using this tool.  Were there a lot of 
problems, or did groups find this fairly easy to do?  Are they ready to build 
their own database from scratch as opposed to filling in predefined fields? 
Note also the last criteria on the rubric. 
 

Credits Images are from the Microsoft Clip Art Gallery Online  
(http://dgl.microsoft.com/)  
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Short Story Wrap-Up 
 
“The question of her decision is one not to be lightly considered, and it is not for me to presume to set 
up myself as the one person able to answer it.  So I leave it with all of you: Which came out of the 
open door – the lady or the tiger?” - Frank R. Stockton 
 
As part of our review for the short stories we have studied as a class in the short story unit, AND as a 
challenge to apply the elements of the short story as you have become familiar with them during this 
unit, as a group, you will do the following: 
 

5. Open the database called “shortstories.fp5” on your computers.  You will need to open File 
Maker Pro and then from the File > Open menu, open this database.  You’ll notice that a 
sample short story, “The Gift of the Magi,”  has already been entered into the database.  When 
you are ready to enter your record (you’ll create one new record for each of your poems) you 
can use the Records > New Record menu. 

6. Your instructor will assign to your group TWO short stories that we have already studied (so 
this should be a quick review!).  Decide on a group name, and tell the instructor what your 
group name will be. Your group name is: _________________. 

7. Your short stories (and their locations) are: 
 

Name of Your Short Stories Page Number in Text 
  
  
  
 
8. For each short story, enter information about that short story into the database, using the 

database as your guide.  The database fields and a description of the fields are below.   To enter 
the data, you’ll need to carefully review the short stories that we have studied, and then apply 
your knowledge of the terms you have learned during this unit to all the short stories.  For 
example, you learned about the term “irony” today, and you’ll have to carefully review 
previous short stories to see if there are examples of irony. 

 
Name of short story – In this field, type in the exact name of the short story. 
Author of short story – In this field, type in the author’s name, first and last (ex. Frank Stockton). 
General description of the short story – Provide a summary of what the short story is about; for 
example, you might say that “The Gift of the Magi” is about a young couple, Jim and Della, who are 
very much in love and very poor.  The each sacrifice their greatest treasure (her hair, his watch) to buy 
each other a Christmas gift.  However, their gifts to each other are useless, because he bought her 
combs for her hair (and now she has none), and she bought him a fob chain for his wath (and he sold it 
to buy her the combs). 
Protagonist(s): Name the stories main characters 
Antagonist: Name the stories main villains or elements that serve as the antagonist 
Describe the setting: Where and when does the story take place 
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Foreshadowing used: Give any examples that might be seen as foreshadowing from your story, for 
example, when Della spends a lot of time combing her hair at the beginning of “The Gift of the Magi,” 
this seems to set the reader’s expectations that something might happen to her hair 
Exposition: Describe what happens in this part of the story 
Rising Action: Describe some of the events that take place in the rising action of the story 
Climax: What is the highest point of interest in the story 
Falling Action: Describe some of the events in the falling action of the story 
Resolution: How is the story resolved?  Or is it? 
Denouement:  Are their any events after the resolution, such as a footnote or epilogue? 
Internal Conflict:  Give an example of internal conflict in the story 
External Conflict: Give an example of external conflict in the story 
Point of View: From what point of view is the story told 
Theme: What is one of the possible themes for this story?  What insight into life does the author give 
us? 
Irony:  Find an example of irony in your story 
 
NOTE: It is possible that your short story may not have EVERY one of these elements.  If in doubt, 
please ask the instructor if your group can’t figure this out, as this activity will be graded! 
 

9. When you are finished, please save your database to the disk the instructor has given to you.   
e. File > Save a Copy As 
f. For your file name, please use your group name. 
g. Write your group name, and the names of each person in your group, on the disk label. 
h.  Turn the disk into your instructor. 
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Evaluation Rubric for Short Story Wrap-Up 
activities 
 
“The question of her decision is one not to be lightly considered, and it is not for me to presume to set up myself as the 
one person able to answer it.  So I leave it with all of you: Which came out of the open door – the lady or the tiger?” - 
Frank R. Stockton 
 
Group Members:    ___________________ 

___________________ 
___________________ 
___________________ 

 
100 possible points Total 

Possible 
Your 
Score 

You’ve correctly identified both the title and author of your 
short stories. 

10  

You’ve provided a good general description/summary of the 
short story that would help someone who has never read it 
understand what it is about. 

10  

You’ve correctly identified one example of each short story 
element that you were asked to find for each short story, and not 
left any examples out UNLESS the short story clearly did not 
use that particular element: 
! Protagonist 
! Antagonist 
! Setting 
! Elements of plot [foreshadowing, exposition, rising 

action, climax, falling action, resolution, denouement, 
irony] 

! Conflict 
! Point of view 
! Theme 

70  

Your group correctly entered the data into the database fields, 
and followed the directions in saving and submitting the 
assignment to the instructor. 

10  

Total Score:
Comments: 
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Short Story Unit Credits: 
 
Annotated Teacher’s Edition Prentice Hall Literature Gold, published by Prentice Hall, 1996, Upper 
Saddle River, New Jersey.   
 
Images are from the Microsoft Clip Art Gallery Online  (http://dgl.microsoft.com/). 
 
Judy Darling, a dear friend and outstanding teacher at Garner Senior High School, who loaned me 
teacher’s editions of books and materials that helped me complete this unit plan. 
 
Teacher’s Wraparound Edition Glencoe Literature, The Reader’s Choice, Course 4, published by 
Glencoe McGraw-Hill, New York: 2000. 
 
 
 

 
 
 
 


